## Request for Changing an Existing Course

<table>
<thead>
<tr>
<th>Department</th>
<th>GEOGRAPHY &amp; ANTH</th>
<th>College</th>
<th>HSS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course Title</td>
<td>GEOG2040</td>
<td>Date</td>
<td>01/26/17</td>
</tr>
</tbody>
</table>

### Present Course Description

<table>
<thead>
<tr>
<th>Title</th>
<th>Geospatial technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>Semester Hours of Credit</td>
<td>3</td>
</tr>
<tr>
<td>If combination course type, # hrs. of credit for</td>
<td>Lecture: 2, Lab/Sem/Rec: 2</td>
</tr>
<tr>
<td>Repeat Credit Max. (if repeatable):</td>
<td>Yes, No</td>
</tr>
<tr>
<td>Graduate Credit?</td>
<td>Yes, No</td>
</tr>
<tr>
<td>Credit will not be given for this course and:</td>
<td></td>
</tr>
<tr>
<td>Contact Hours Per Week: (Indicate hours in appropriate course type.)</td>
<td></td>
</tr>
<tr>
<td>Lecture</td>
<td>2</td>
</tr>
<tr>
<td>Lab</td>
<td>2</td>
</tr>
<tr>
<td>Seminar</td>
<td></td>
</tr>
<tr>
<td>Recitation</td>
<td></td>
</tr>
<tr>
<td>Intern</td>
<td></td>
</tr>
<tr>
<td>Res/Ind</td>
<td></td>
</tr>
<tr>
<td>Clin/Pract</td>
<td></td>
</tr>
<tr>
<td>Total Weekly Contact Hours:</td>
<td>3</td>
</tr>
<tr>
<td>Grading System:</td>
<td>Letter Grade X, Pass/Fail</td>
</tr>
</tbody>
</table>

Course Description:
GEOG 2040 Geospatial Technology (3) 2 hrs lecture; 2 hrs. lab. Introduction to concepts and applications of modern geospatial technologies to various disciplines. Discusses the collection, input, storage, analysis, and visualization of spatial and attribute data.

### Proposed Course Description

<table>
<thead>
<tr>
<th>Title</th>
<th>Geospatial technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Title</td>
<td>G E C T E C H</td>
</tr>
<tr>
<td>Semester Hours of Credit</td>
<td>3</td>
</tr>
<tr>
<td>If combination course type, # hrs. of credit for</td>
<td>Lecture: 3, Lab/Sem/Rec:</td>
</tr>
<tr>
<td>Repeat Credit Max. (if repeatable):</td>
<td>Yes, No</td>
</tr>
<tr>
<td>Graduate Credit?</td>
<td>Yes, No</td>
</tr>
<tr>
<td>Credit will not be given for this course and:</td>
<td></td>
</tr>
<tr>
<td>Contact Hours Per Week: (Indicate hours in appropriate course type.)</td>
<td></td>
</tr>
<tr>
<td>Lecture</td>
<td>3</td>
</tr>
<tr>
<td>Lab</td>
<td>2</td>
</tr>
<tr>
<td>Seminar</td>
<td></td>
</tr>
<tr>
<td>Recitation</td>
<td></td>
</tr>
<tr>
<td>Intern</td>
<td></td>
</tr>
<tr>
<td>Res/Ind</td>
<td></td>
</tr>
<tr>
<td>Clin/Pract</td>
<td></td>
</tr>
<tr>
<td>Total Weekly Contact Hours:</td>
<td>3</td>
</tr>
<tr>
<td>Grading System:</td>
<td>Letter Grade X, Pass/Fail</td>
</tr>
</tbody>
</table>

Course Description:
GEOG 2040 Geospatial Technology (3) Introduction to concepts and applications of modern geospatial technologies to various disciplines. Discusses the collection, input, storage, analysis, and visualization of spatial and attribute data.

THES QUESTIONS MUST BE ANSWERED COMPLETELY AND ACCURATELY OR PROPOSAL WILL BE RETURNED:

- Has this change been discussed with and approved by all departments/colleges affected? Yes, No, N/A X
- Is this course included in any curricula, concentrations, or minors? Yes, No. If yes, please list on a separate sheet.
- Is this course a prerequisite or corerequisite for other courses? Yes, No. If yes, list courses; use separate sheet.
- Is this course on the General Education list? Yes, No X

Justification/Explanation: Use separate sheet.

Note: IF COURSE IS OR WILL BE CROSS-LISTED, SEPARATE FORMS MUST BE SUBMITTED BY EACH DEPARTMENT.

### Approvals

<table>
<thead>
<tr>
<th>Department Faculty Approval Date</th>
<th>01/13/17</th>
</tr>
</thead>
<tbody>
<tr>
<td>College Faculty Approval Date</td>
<td>2/15/17</td>
</tr>
</tbody>
</table>

Department Chair Signature (date) 9/17/17
Graduate Dean Signature (date) 3/11/17

College Contact E-mail
Justification:

This course is being changed from a format of two laboratory hours and two lecture hours to a format of three lecture hours. This format change is a response to low enrollments that have persisted for several years. The current format only allows the course to be scheduled in late afternoon MW or TTh. The new format will allow the course to be scheduled during prime hours and potentially attract more students. Further, student comments indicate dissatisfaction with a requirement of four contact hours for a course that provides three credit hours. The change will alleviate this situation. Finally, the laboratory period is comprised of in-class assignments that are conducted under the direction of the instructor. Similar activities are conducted in many courses without the laboratory designation.

Curricula, Concentrations, and Minors:

This course is a requirement for the following:

- GEOG BS
- GEOG BS (Disaster Science and Management concentration)
- GEOG BS (Geographic Information Science concentration)
- GEOG BA
- GEOG BA (Disaster Science and Management concentration)
- GEOG BA (Geographic Information Science concentration)
GEOG 2040 - GEOSPATIAL TECHNOLOGY
SPRING 2017
Tuesdays and Thursdays 3:00pm - 4:20pm
260 Howe-Russell Bldg

Instructor: Michael Leitner
office E104 H/R Bldg
phone 578-2963
e-mail mleitne@lsu.edu

Teaching Assistant: Samira Soleimani
office 445 H/R Bldg
e-mail sssole1@lsu.edu

Office hours: Tu & Th, 9:00am-10:30am
& by appointment

Office hours: Mo & We 10:00-12:00am

According to Shellito (2016) Geospatial Technology describes the use of a number of different high-tech systems and tools that acquire, analyze, manage, store, or visualize various types of location-based data. Such systems and tools include:

- **Geographic Information System (GIS):** Computer-based mapping, analysis, and retrieval of location-based data.
- **Remote Sensing:** Satellite imagery, aerial photography (e.g., with drones), spatial video acquisition system, etc.
- **Global Positioning System (GPS):** Acquisition of real-time location information from a series of satellites in Earth’s orbit.
- **Spatial Statistics:** GIS, CrimeStat, GeoDA, etc.

Geospatial Technology is used at all level of governments, including academia, and the private sector. It is truly an interdisciplinary technology and ranges from geography, anthropology, law enforcement, forestry, to public health, and environmental studies, just to mention a few.

**PREREQUISITES FOR THIS COURSE:** None


**IN-CLASS EXERCISES:** In-class assignments will be handed out and discussed during class. All exercises are taken from Shellito (2016) and included at the end of each chapter. Two sample exercises are attached at the end of this syllabus. Students will be expected to use class periods for guidance and assistance in completing these assignments.

**GRADING:** One mid-term exam and one final exam (take-home exam) will be scheduled during the semester. The mid-term exam will consist of multiple choice questions, defining geospatial technology terms, and short essay questions. The take-home exam includes a series of essay questions, only. Each exam will count for 25% of the final grade. A series of in-class exercises (11) will be assigned which (taken as a group) will count for 50% of the course grade. I do not accept any exercises handed in to me after the final class (Thursday, April 27). The grading policy in this course is as follows: A+: 98-100%; A: 92-<98%; A-: 90-<92%; B+: 88-<90%; B: 82-<88%; B-: 80-<82%; C+: 78-<80%; C: 72-<78%; C-: 70-<72%; D+: 68-<70%; D: 62-<68%; D-: 60-<62%; F: <60%.
FINAL EXAM: Take-Home Exam

IN-CLASS EXERCISES
Exercise 1: Introduction to Geospatial Concepts and Google Earth
Exercise 2: Coordinates and Position Measurements
Exercise 3: Georeferencing an Image
Exercise 4: GNNS Applications
Exercise 7: GIS Layouts: ArcGIS Version; GIS Layouts: QGIS Version
Exercise 8: Geocoding and Shortest Path Analysis
Exercise 9: Visual Imagery Interpretation
Exercise 10: Remotely Sensed Imagery and Color Composites
Exercise 11: Landsat 8 Imagery

TENTATIVE CLASS SCHEDULE

<table>
<thead>
<tr>
<th>WEEK</th>
<th>LECTURE</th>
<th>EXERCISE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Jan 12</td>
<td>Introduction</td>
</tr>
<tr>
<td>2</td>
<td>Jan 17</td>
<td>Geospatial technology and data, geolocation (Shellito, Ch. 1)</td>
</tr>
<tr>
<td></td>
<td>Jan 19</td>
<td>Datum, coordinate systems, UTM, SPCS (Shellito, Ch. 2), visit of CIC</td>
</tr>
<tr>
<td>3</td>
<td>Jan 24</td>
<td>Georeferencing (Shellito, Ch. 3)</td>
</tr>
<tr>
<td></td>
<td>Jan 26</td>
<td>Global Positioning System 1 (Shellito, Ch. 4)</td>
</tr>
<tr>
<td>4</td>
<td>Jan 31</td>
<td>Global Positioning System 2 (Shellito, Ch. 4)</td>
</tr>
<tr>
<td></td>
<td>Feb 02</td>
<td>Introduction to Geographic Information System 1 (Shellito, Ch. 5)</td>
</tr>
<tr>
<td>5</td>
<td>Feb 07</td>
<td>Introduction to Geographic Information System 2 (Shellito, Ch. 5)</td>
</tr>
<tr>
<td></td>
<td>Feb 09</td>
<td>Basic spatial analysis in GIS (Shellito, Ch. 6)</td>
</tr>
<tr>
<td>6</td>
<td>Feb 14</td>
<td>Map scale, map design (Shellito, Ch. 7)</td>
</tr>
<tr>
<td></td>
<td>Feb 16</td>
<td>Color use in a map (Shellito, Ch. 7)</td>
</tr>
<tr>
<td>7</td>
<td>Feb 21</td>
<td>Address matching, networks, shortest path (Shellito, Ch. 8)</td>
</tr>
<tr>
<td></td>
<td>Feb 23</td>
<td>Class Review</td>
</tr>
<tr>
<td>8</td>
<td>Feb 28</td>
<td>Mardi Gras holiday</td>
</tr>
<tr>
<td></td>
<td>Mar 02</td>
<td>Mid-Term Exam</td>
</tr>
<tr>
<td>9</td>
<td>Mar 07</td>
<td>Aircraft photography, interpretation, measurements (Shellito, Ch. 9)</td>
</tr>
<tr>
<td></td>
<td>Mar 09</td>
<td>Unmanned aerial vehicle (Shellito, Chapter 9)</td>
</tr>
<tr>
<td>10</td>
<td>Mar 14</td>
<td>RS 1 (atmosphere, spectral reflectance, image display) (Shellito, Ch. 10)</td>
</tr>
<tr>
<td></td>
<td>Mar 16</td>
<td>Remote sensing 2 (data collection, sensor capabilities, monitoring) (Shellito, Ch. 11)</td>
</tr>
<tr>
<td>11</td>
<td>Mar 21</td>
<td>Remote sensing 2 cont. (Landsat, sensor resolutoin, monitoring) (Shellito, Ch. 11)</td>
</tr>
<tr>
<td></td>
<td>Mar 23</td>
<td>Spatial Video Acquisition System</td>
</tr>
</tbody>
</table>
Mar 28  NASA’s Earth Observing System Program *(Shellito, Ch. 12)*
Mar 30  Terra, Aqua, Aura, Suomi NPP *(Shellito, Ch. 12)*

Apr 04  Terrain representation, Digital Elevation Model *(Shellito, Ch. 13)*
Apr 06  3D modeling *(Shellito, Ch. 14)*

Apr 11  Spring Break
Apr 13  Spring Break

Apr 18  Geospatial Cloud *(Shellito, Ch. 15)*
Apr 20  Geospatial technology and crime modeling and mapping

Apr 25  Class Review
Apr 27  Take-Home Exam

**COURSE POLICIES**

*Academic Misconduct and Classroom Etiquette:* Students are expected to abide by the LSU student code of conduct. Students are also expected to abide by the basic rules of classroom etiquette including: getting to class on time and coming prepared to engage; turning off all electronic devices; not talking during lectures; and remaining respectful of diverse views when engaging in classroom debate. All views are allowed and welcome; however, expressing them in a respectful way is required. Reasonable people can disagree, but disagreement needs to be expressed in ways that are conducive to the free exchange of ideas, productive dialogue, and meaningful learning.

*Missed Classes:* If you miss a class, you will be required to provide written documentation of a valid reason for your absence within one week of the day (see LSU Policy Statement 22, posted on the course website, for examples of valid reasons for absences). Missing class more than once or twice is likely to compromise your grade.

*Missed Exams:* If you miss an exam, you will be required to provide written documentation of a valid reason for your absence within a reasonable time-frame (see LSU Policy Statement 22, posted on the course website, for examples of valid reasons for absences). All make-up exams will be administered at my discretion and at a time and place of my choosing.

*Disability:* Any student who feels he/she may need an accommodation based on the impact of a disability should contact the professor privately to discuss specific needs. Also, contact the LSU Disability Services at (225) 578-5919 as soon as possible to better ensure that accommodations are implemented in a timely fashion.

*Credit hour expectation statement:* LSU’s general policy states that for each credit hour, you (the student) should plan to spend at least two hours working on course related activities outside of class. Since this course is for three credit hours, you should expect to spend a minimum of six hours outside of class each week working on assignments for this course. For more information see: [http://catalog.lsu.edu/content.php?catoid=12navoid=822](http://catalog.lsu.edu/content.php?catoid=12navoid=822).
EXAMPLES OF TWO IN-CLASS EXERCISES (SEE ATTACHED)

Exercise 2: Coordinates and Position Measurements (Shellito 2016, pgs. 59-65)
Exercise 10: Remotely Sensed Imagery and Color Composites (Shellito 2016, pgs. 362-371)
2.1 Geospatial Lab Application

Coordinates and Position Measurements

This chapter’s lab will continue using Google Earth Pro (GE), but only to examine coordinate systems and the relationships between various sets of coordinates and the objects they represent in the real world. In addition, you’ll be making some measurements using GE and using some Web resources for comparing measurements made by using different coordinate systems.

Note that this lab makes reference to things like “coordinates for the White House” or “coordinates for Buckingham Palace”—these represent measuring a set of coordinates at one specific location at these places and are used as simplifications of things for lab purposes.

Objectives
The goals for you to take away from this lab are:

► To set up a graticule of lines in GE
► To locate places and objects strictly by their coordinates
► To make measurements across long and short distances and then compare measurements with surface distance calculations
► To translate latitude/longitude coordinates into UTM

Using Geospatial Technologies
The concepts you’ll be working with in this lab are used in a variety of real-world applications, including:

► Emergency rescue and relief operations, which need exact coordinates in order to locate incidents (like stranded civilians and downed power lines) and send the closest available emergency assistance

► Outdoor event planners, which need to know the coordinates of every entrance and exit to all buildings, temporary structures, and enclosures, as well as the locations of essential resources and amenities, like first aid rooms and other emergency services (on- and off-site), handicapped-accessible ramps, and restrooms (for both the disabled and the able-bodied)
Obtaining Software

The current version of Google Earth Pro (7.1) is available for free download at www.google.com/earth/explore/products/desktop.html.

*Important note:* Software and online resources can change fast. This lab was designed with the most recently available version of the software at the time of writing. However, if the software or Websites have significantly changed between then and now, an updated version of this lab (using the newest versions) will be available online at www.macmillanhighered.com/shellito/catalog.

Lab Data

There is no data to copy in this lab. All data comes as part of the GE data that is installed with the software or is streamed across the Internet through GE.

Localizing This Lab

This lab flies around the world to numerous locations, including Washington, D.C., and London. However, it can easily be changed to examine the coordinates of nearby areas. Rather than looking at the White House or Buckingham Palace, substitute the coordinates or locations for your own local government offices (like city halls or courthouses).

2.1 Examining Coordinates and Distance Measurements in Google Earth

1. Start GE. Once Earth settles into view, scroll your mouse around Earth. You'll see a set of latitude and longitude coordinates appear at the bottom of the view—these represent the coordinates assigned to your
mouse's location. By default, GE uses the GCS coordinate system and
the WGS84 datum.

2. To examine the full graticule of latitude and longitude lines, select
Grid from the View pull-down menu. Some key GCS lines will be
highlighted in yellow amidst the web of lat/long lines—the Equator, the
Prime Meridian, the Antimeridian (how Google Earth labels the 180th
meridian), the Tropic of Cancer, and the Tropic of Capricorn.

3. We'll begin in Washington, D.C., so type Washington, D.C. into the
Search box. GE will rotate and zoom to the area. You'll also see the
spaces between the lat/long lines grow smaller and new values appear
as GE zooms in.

4. Next, we'll go a specific location in Washington, D.C. Type these
coordinates into the Search box: 38.897631, -77.036566. These are the
decimal degree lat/long coordinates of the White House.

5. Press the Placemark button on the toolbar (see Geospatial Lab
Application 1.1 for more information on placemarks). The yellow
pushpin will automatically be placed at the lat/long coordinates you had
GE search for (so you don't have to place it anywhere manually). In the
new placemark dialog box, type The White House for the name of the
placemark and select another symbol for the yellow pushpin if you like.

6. The coordinates for the White House are in decimal degrees, but other
methods of displaying coordinates are available in GE. From the Tools
pull-down menu, select Options.
Chapter 2  WHERE IN THE GEOSPATIAL WORLD ARE YOU?

7. In the Show Lat/Long options, select the radio button next to Degrees, Minutes, Seconds, click Apply, and then click OK.

8. From the Places box in GE, right-click on the White House placemark, and then select Properties. The coordinates will be changed to degrees, minutes, and seconds (DMS). Answer Question 2.1. Close the White House placemark dialog box.

**Question 2.1** What are the coordinates for the White House in degrees, minutes, and seconds?

9. Decimal degree coordinates for the Lincoln Memorial are: 38.889257, -77.050137. Use the Search box to zoom to these coordinates. Once GE arrives there, put a placemark at that spot, name it Lincoln Memorial, and answer Question 2.2.

**Question 2.2** What are the coordinates for the Lincoln Memorial in degrees, minutes, and seconds?

10. Adjust the view so you can see both placemarks at the edges of the view. Select the Ruler tool and compute the distance between the White House and the Lincoln Memorial (see Geospatial Lab Application 1.1 for the use of the Ruler tool in measurements of distance). Answer Question 2.3. Turn off the placemark for the Lincoln Memorial when you're done.

**Question 2.3** According to GE, what is the distance between the White House and the Lincoln Memorial?

11. It's such a short distance from the White House to the Lincoln Memorial that the differences between measurements should be very small, so let's look at some larger distances.

12. Buckingham Palace (in London, England) is located at these coordinates: 51.500821, -0.143089. Use the Search box to zoom to these coordinates. Once GE arrives there, put a placemark at that spot, name it Buckingham Palace, and then answer Question 2.4.

**Question 2.4** What are the coordinates for Buckingham Palace in degrees, minutes, and seconds?

13. Zoom out and rotate the view so that you can see the placemarks for the White House and for Buckingham Palace in the same view. Use the Ruler to compute the distance between these two locations. Answer Questions 2.5 and 2.6. Close the Ruler dialog box when you're done. Of course, this is a rough estimate because the scale of the view makes hitting the placemarks directly with the start point and the end point of the ruler difficult.
Question 2.5 According to your measurement in GE, what is the computed distance (in miles) between the White House and Buckingham Palace?

Question 2.6 Why is the line curved rather than straight? What kind of distance is being computed here?

14. We'll now check your measurements using a Web utility. Go to www.chemical-ecology.net/java/lat-long.htm. This Website enables you to compute the surface (real-world) distance between two sets of lat/long coordinates (and also between two cities) in DMS format.

15. Use your answer to Question 2.1 as the degrees, minutes, and seconds for the latitude and longitude of point one (you are using North latitude and West longitude).

16. Use your answer to Question 2.4 as the degrees, minutes, and seconds for the latitude and longitude of point two (you are again using North latitude and West longitude).

17. Click the Distance Between button. The surface distance between the two points will be computed in kilometers, miles, and nautical miles. Answer Question 2.7. Your answers to Questions 2.5 and 2.7 should be relatively similar, given how they were both computed—if they're way off, redo your Question 2.5 measurement and make sure you're inputting the correct numbers for Question 2.7.

Question 2.7 According to this Website measurement, what is the computed surface distance (in miles) between the White House and Buckingham Palace?

2.2 Using UTM Coordinates and Measurements in Google Earth

Universal Transverse Mercator (UTM) is a projected coordinate system, and GE can track coordinates using this UTM system as well as lat/long.

1. From GE's Tools pull-down menu, select Options. In the Show Lat/Long options, select the radio button for Universal Transverse Mercator. Click Apply, and then click OK.
2. Zoom out to see the whole world—you'll also see that the graticule has changed from a web of latitude/longitude lines to the UTM grid draped over Earth. You should see the UTM zones laid out across the world, numbered from 1 through 60.

**Question 2.8** What UTM zone is Buckingham Palace located in? What UTM zone is the White House located in?

3. Double-click on the White House placemark (in the Places box) and GE will rotate and zoom back to the White House.

4. Scroll the mouse around the White House area. You'll see the new coordinates appear at the bottom of the view, but this time they'll be the zone, easting, and northing measurements. Open the Properties of the White House placemark by right-clicking on it. The UTM easting, northing, and zone will appear.

**Question 2.9** What are the UTM coordinates of the White House?

5. In the Places box, double-click on the Lincoln Memorial placemark, and GE will zoom and rotate to it.

**Question 2.10** What are the UTM coordinates of the Lincoln Memorial?

6. UTM coordinates are measured in meters rather than degrees of latitude or longitude—this enables an easier method of determining coordinates. If you move the mouse east, your easting will increase,
and moving it west will decrease the easting. The same holds true for northing—moving the mouse north will increase the value of northing, while moving it south will decrease the northing value.

7. Change the view so that you can see both the White House and the Lincoln Memorial. Using your answers for Questions 2.9 and 2.10 (and perhaps the Ruler tool), answer Question 2.11.

**Question 2.11** How many meters away to the north and east is the White House from the Lincoln Memorial?

8. UTM can also be used to determine the locations of other objects. Return to the White House placemark again. Answer Questions 2.12 and 2.13.

**Question 2.12** What object is located approximately 912 meters south and 94.85 meters east of the White House?

**Question 2.13** What are the full UTM coordinates of this object?

---

**Closing Time**

This lab served as an introduction for using and referencing coordinates and measurements, using Google Earth. Chapter 3’s lab will use a new software program, but we’ll return to Google Earth in Chapter 8, and we’ll continue to use its functions in other chapters. You can now exit GE by selecting Exit from the File pull-down menu. There’s no need to save any data (or Temporary Places) in this lab.
Remotely Sensed Imagery and Color Composites

This chapter's lab will introduce you to some of the basics of working with multispectral remotely sensed imagery through the use of the MultiSpec software program.

Objectives
The goals to take away from this exercise are:

▶ To familiarize yourself with the basics of the MultiSpec software program
▶ To load various bands into the color guns and examine the results
▶ To create and examine different color composites
▶ To compare the brightness values of distinct water and environmental features in a remotely sensed satellite image in order to create basic spectral profiles

Using Geospatial Technologies
The concepts you'll be working with in this lab are used in a variety of real-world applications, including:

▶ Environmental science, which uses satellite imagery to derive signatures for various classes of land cover and to create accurate land cover maps
▶ Urban planning, where satellite imagery collected over time can be used to study the expansion (and sometimes the contraction) of cities and to evaluate proposals for commercial, industrial, and residential development
Obtaining Software

The current version of MultiSpec (3.4) is available for free download at https://engineering.purdue.edu/~biehl/MultiSpec.

*Important note:* Software and online resources can change fast. This lab was designed with the most recently available version of the software at the time of writing. However, if the software or Websites have significantly changed between then and now, an updated version of this lab (using the newest versions) will be available online at www.macmillanhighered.com/shellito/catalog.

Lab Data

Copy the folder Chapter10—it contains a Landsat 8 OLI/TIRS satellite image (called "cle.img") from 9/27/2014 of Cleveland, OH. This file shows a subset of a larger Landsat satellite image. We will discuss more about Landsat imagery in Chapter 11, but the OLI and TIRS imagery bands refer to the following portions of the electromagnetic (EM) spectrum in micrometers (μm):

- Band 1: Coastal (0.43 to 0.45 μm)
- Band 2: Blue (0.45 to 0.51 μm)
- Band 3: Green (0.53 to 0.59 μm)
- Band 4: Red (0.64 to 0.67 μm)
- Band 5: Near infrared (0.85 to 0.88 μm)
- Band 6: Shortwave infrared 1 (1.57 to 1.65 μm)
Band 7: Shortwave infrared 2 (2.11 to 2.29 μm)
Band 8: Panchromatic (0.50 to 0.68 μm)
Band 9: Cirrus (1.36 to 1.38 μm)
Band 10: Thermal infrared 1 (10.60 to 11.19 μm)
Band 11: Thermal infrared 2 (11.50 to 12.11 μm)

Keep in mind that Landsat 8 imagery has a 30-meter spatial resolution (except for the panchromatic band, which is 15 meters). Thus, each pixel you will examine covers a 30 meter by 30 meter sized area on the ground.

Localizing This Lab
Although this lab focuses on a section of a Landsat scene from northeast Ohio, Landsat imagery is available for free download via LandsatLook at http://landsatlook.usgs.gov. This site will provide raw data that will have to be imported into MultiSpec and processed to use in the program. Information for using this free Landsat data for use in MultiSpec is available at https://engineering.purdue.edu/~biehl/MultiSpec/tutorials/MultiSpec_Tutorial_5.pdf.

10.1 MultiSpec and Band Combinations

1. Start MultiSpec. MultiSpec will start with an empty text box (which will give you updates and reports of processes in the program). You can minimize the text box for now.

2. To get started with a remotely sensed image, select Open Image from the File pull-down menu. Alternatively, you can select the Open icon from the toolbar:

[Source: Purdue Research Foundation]

3. Navigate to the Chapter10 folder, select cle.img as the file to open, and click Open.

4. A new dialog box will appear that allows you to set the display specification for the “cle” image.
5. Under Channels, you will see the three color guns available to you (red, green, and blue). Each color gun can hold one band (see the Lab Data section for a listing of which bands correspond to which parts of the electromagnetic spectrum). The number listed next to each color gun represents the band being displayed with that gun.

6. Display band 5 in the red color gun, band 4 in the green color gun, and band 3 in the blue color gun.

7. Accept the other defaults for now and click OK.

8. A new window will appear and the “cle” image will begin loading. This might take a minute or two to load completely.

9. For the best results, maximize both MultiSpec and the window containing the “cle” image. Use the bars at the edge of the window to move around the image. You can zoom in or zoom out by using the zoom tools on the toolbar:
The large mountain icon will zoom in and the small mountain icon will zoom out.

10. Zoom around the image, paying attention to some of the city, landscape, and water areas.

| Question 10.1 | What wavelength bands were placed into which color guns? |
| Question 10.2 | Why are the colors in the image so strange compared to what we’re normally used to seeing in other imagery (such as Google Earth or Google Maps)? For example, why is most of the landscape red? |
| Question 10.3 | In this color composite, what colors are the water, vegetated areas, and urban areas displayed as in the image? |

11. Reopen the image, this time using band 4 in the red gun, band 3 in the green gun, and band 2 in the blue gun (referred to as a 4-3-2 combination). Once the image reloads, pan and zoom around the image, examining the same areas you just looked at.

| Question 10.4 | What kind of composite did we create in this step? How are the bands being displayed in this color composite in relation to their guns? |
| Question 10.5 | Why can we not always use this kind of composite (from Question 10.4) when analyzing satellite imagery? |

12. Reopen the image yet again, this time using band 7 in the red gun, band 5 in the green gun, and band 3 in the blue gun (referred to as a 7-5-3 combination). Once it reloads, pan and zoom around the image, examining the same areas you just looked at.

| Question 10.6 | Once again, what kind of composite was created in this step? |
| Question 10.7 | How are vegetated areas being displayed in this color composite (compared with the arrangement in Question 10.4)? Why are they displayed in this color? |
10.2 Examining Color Composites and Color Formations

1. Reopen the image one more time, returning to the 5-4-3 combination (band 5 in the red gun, band 4 in the green gun, and band 3 in the blue gun). You can close the other images, as we'll be working with this one for the rest of the lab.

2. Zoom and move around the image to find and examine Burke Lakefront Airport as follows:

![Image of Burke Lakefront Airport]

(Source: Multispec/Purdue Research Foundation)

3. Zoom in to the airfield. From its shape and the pattern of the runways, you should be able to clearly identify it in the Landsat image.
4. Examine the airfield and its surroundings.

**Question 10.8** Why do the areas in between the runways appear red?

5. Open a new image, this time with a 4-5-3 combination. Examine Burke Lakefront Airport in this new image and compare it to the one you’ve been working with.

**Question 10.9** Why do the areas in between the runways now appear bright green?

6. Open another new image, this time with a 4-3-5 combination. Examine Burke Lakefront Airport in this new image and compare it with the others you’ve been working with.

**Question 10.10** Why do the areas in between the runways now appear blue?

7. At this point, only keep the 5-4-3 image open and close the other two.
10.3 Examining Specific Brightness Values
and Spectral Profiles

Regardless of how the pixels are displayed in the image, each pixel in each band of the Landsat 8 image has a specific brightness value set in the 0–65536 range. By examining those pixel values for each band, you can chart a basic "spectral profile" of some features in the image.

1. Zoom in to the area around Cleveland's waterfront and identify the urban areas (in the image these will mostly be the white or cyan regions).

2. From the Window pull-down menu, select New Selection Graph. Another (empty) window (called Selection Graph) will open in MultiSpec.

3. In the image, locate a pixel that's a good example of an urban or developed area. The cursor will change to a cross shape, so give the pixel one more click.

   Important note: Zoom in so that you are only selecting one pixel with the cursor.

4. A chart will appear in the Selection Graph window that will graphically show the BVs for each band at that particular pixel (see the first page of this lab for the portions of the electromagnetic spectrum that match up with each band). The band numbers are on the x-axis and the BVs are on the y-axis. The chart can be expanded or maximized as necessary to be better able to examine the values.

   ![Selection Graph](Source: Multispec/Purdue Research Foundation)
5. The Selection Graph window now shows the data that can be used to compute a simplified version of a spectral profile for an example of the particular urban land use pixel you selected from the image.

6. For the next question, you'll be required to find a pixel that's a good example of water and another pixel that's a good example of vegetation. You'll also be required to translate the data from the chart to a spectral profile for each example. In drawing the profiles from the information on the chart, keep two things in mind:
   a. First, the values at the bottom of the Selection Graph window represent the numbers of the bands being examined. On the chart below, the actual wavelengths of the bands are plotted out, so be very careful to make sure you properly match up each band with its respective wavelength. Note that bands 10 and 11 are not being charted, since they measure emitted thermal energy rather than reflected energy like bands 1 through 9. Also note that band 8 (panchromatic) is not charted as well.
   b. Second, the values on the y-axis of the Selection Graph window are BVs, not the percentage of reflection as seen in a spectral signature diagram. There are a number of factors involved with transforming BVs into the actual percent reflectance values (a BV and the percent reflectance don't have an exact one-to-one ratio, as there are other factors that affect the measurement at the sensor, such as atmospheric effects), but in this simplified example, you'll just chart the BV for this spectral profile.

7. Examine the image for a good example of a water pixel and a vegetation pixel.

8. Plot a spectral profile diagram for the water and vegetation pixels you chose on the following diagram (remember to plot values as calculated from the BVs).

![Spectral Profile Diagram]

([Source: Multispec/Purdue Research Foundation])

**Question 10.11** What information can you gain from the spectral profile for water about the ability of water to reflect and absorb energy (that is, what types of energy are most reflected by water, and what types of energy are most absorbed by water)?

**Question 10.12** What information can you gain from the spectral profile for vegetation about the ability of vegetation to reflect and absorb energy (that is, what types of energy are most reflected by vegetation, and what types of energy are most absorbed by vegetation)?

10. Exit MultiSpec by selecting Exit from the File pull-down menu. There's no need to save any work in this exercise.

---

**Closing Time**

Now that you have the basics of working with remotely sensed data and examining the differences in color composites, the next two chapters will build on these skills. The Chapter 11 lab will return to using MultiSpec for more analysis of Landsat satellite imagery.